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there’s an executable called �]�D�S, which will start the 
�+�&�'�����+�H���[�Q�W�h�X�G���W�U�G�F���V�J�G���#�T�F�W�K�P�Q���+�&�'���D�G�H�Q�T�G�����[�Q�W���E�C�P���W�U�G��
Zap in exactly the same way, but it does have a few 
features that are specially for  the Papilio FPGA. You 
may have noticed that there’s an extra menu called 
Papilio, and it’s here that we’ll get started. 

Create a new project (known as a sketch in the 
Arduino terminology). Go to Papilio > New Papilio 
Project, and give it a name.

The programming language used is a dialect of 
C++. The two main functions are �V�H�W�X�S������and �O�R�R�S����. 
The �V�H�W�X�S�������H�W�P�E�V�K�Q�P���K�U���T�W�P���Y�J�G�P���V�J�G���2�C�R�K�N�K�Q���’�T�U�V��
starts, then �O�R�R�S���� runs continuously. In the new 
project you’ve just created, these will contain the code 
to simply turn pin 0 off and on a few times. Actually, 
the default code contains a typo: it uses a variable 
that’s not declared. To correct it, change the loop 
function to:
void loop() {

  digitalWrite(0, HIGH);   // turn the LED on (HIGH is the voltage 

level)

  delay(1000);               // wait for a second

  digitalWrite(0, LOW);    // turn the LED off by making the voltage 

LOW

  delay(1000);               // wait for a second

}

Here, in the two places where the �O�H�G��variable was 
used, we’ve just put in the value 0 instead. This simple 
function sets pin 0 to high, then waits a second (the 
�G�H�O�D�\ function takes the number of milliseconds as 
it’s argument), then puts the pin low, waits another 
second and repeats.

This code isn’t for the FPGA, remember, but for the 
ZPU processor. So, before you can use this code, you 
�J�C�X�G���V�Q���N�Q�C�F���C���$�+�6���’�N�G���E�Q�P�V�C�K�P�K�P�I���V�J�G���R�T�Q�E�G�U�U�Q�T���Q�P�V�Q��
the board. To do this, click on the following link, which 
should be in the comments at the top of the page:
sketchdir://500K/papilio_one_500k.bit

This will write a ZPU processor to the FPGA. Once 
�K�V�h�U���’�P�K�U�J�G�F�����K�V�h�N�N���F�K�U�R�N�C�[���V�J�G���H�Q�N�N�Q�Y�K�P�I���N�K�P�G���K�P���V�J�G���E�Q�P�U�Q�N�G��

at the bottom of the ZAP window:
DONE           = 0

�1�P�E�G���V�J�K�U���K�U���’�P�K�U�J�G�F�����[�Q�W���E�C�P���W�R�N�Q�C�F���[�Q�W�T���E�Q�F�G���V�Q��
the processor by clicking on the arrow icon in the 
top-left corner of the window.

There won’t be any instant sign that it’s worked, so 
�[�Q�W���P�G�G�F���V�Q���E�Q�P�P�G�E�V���C�P���.�'�&���V�Q���V�J�G���C�R�R�T�Q�R�T�K�C�V�G���R�K�P��
along with a resistor to stop it drawing too much 
�E�W�T�T�G�P�V�����#�P�[���E�Q�N�Q�W�T���.�'�&���Y�K�N�N���F�Q�����D�W�V���K�V���P�G�G�F�U���V�Q���D�G��
connected the right way around (one of the legs will 
be a little shorter and there will be a flat side on the 
base. This is the negative leg). To stop it drawing too 
much current, you’ll also need a resistor (any value 
�D�G�V�Y�G�G�P�����������C�P�F���������������Q�J�O�U���Y�K�N�N���D�G���’�P�G������

First, unplug the Papilio. You need to connect the 
�R�Q�U�K�V�K�X�G���N�G�I���Q�H���V�J�G���.�'�&���V�Q���R�K�P���#�.�A�����Q�P���V�J�G���2�C�R�K�N�K�Q���1�P�G����
If you look at the board with the USB port on the top 
side, this is the pin in the middle of the three in the 
�D�Q�V�V�Q�O���T�K�I�J�V���E�Q�T�P�G�T�����6�J�G���P�G�I�C�V�K�X�G���N�G�I���Q�H���V�J�G���.�'�&��
should connect to the resistor, and then the resistor 
should connect to the ground. You’ll need a 
breadboard or some other circuit-building hardware to 
link everything together.

Once all this is connected, plug the Papilio back in 
�C�P�F���V�J�G���.�'�&���U�J�Q�W�N�F���U�V�C�T�V���V�Q���D�N�K�P�M���Q�P���C�P�F���Q�H�H��

Chip tunes
The ZPU in an FPGA is a way to get a slightly more 
powerful Arduino, but the Papilio can be far more than 
just a souped-up microcontroller. The ZPU doesn’t 
take up all of the space in the Papilio One 500K. You 
can use the remaining space to implement additional 
�H�G�C�V�W�T�G�U���V�J�C�V���[�Q�W���O�K�I�J�V���’�P�F���W�U�G�H�W�N����

�)�Q���V�Q���2�C�R�K�N�K�Q��� ���2�C�R�K�N�K�Q���'�Z�C�O�R�N�G�U��� ���#�W�F�K�Q���;�/����������
Simple in the Zap menu. This will open a new sketch 
�V�J�C�V���K�P�E�N�W�F�G�U���C�P���K�O�R�N�G�O�G�P�V�C�V�K�Q�P���Q�H���C���;�/�����������C�W�F�K�Q��
chip. The music geeks among you will know this as 
the audio chip from the Atari ST (and several other 
games systems). This example can be used to play 
�O�W�U�K�E���’�N�G�U���H�T�Q�O���V�J�G�U�G���Q�N�F���U�[�U�V�G�O�U���V�Q���I�G�P�G�T�C�V�G���U�Q�O�G��
retro sounds. 

To see the schematic for the FPGA used in this 
sketch, click on �V�N�H�W�F�K�G�L�U�������V�F�K�H�P�D�W�L�F�B�S�D�S�L�O�L�R�B
�R�Q�H�B�������N���S�G�I. You’ll see that this contains three 

All of the Papilio example 
sketches come with 
schematics showing the 
chip design inside the BIT 
�’�N�G�����U�Q���[�Q�W���E�C�P���U�G�G���Y�J�C�V�h�U��
connected to which pins.

99

Expanding the Papilio

�6�J�G�T�G���C�T�G���V�J�T�G�G���Q�N�E�K�C�N���g�/�G�I�C�9�K�P�I�U�h���O�C�F�G���D�[���V�J�G���)�C�F�I�G�V��
Factory to add features to the Papilio (all are compatible 
with all versions of the board.

  �6�J�G���.�Q�I�K�E�5�V�C�T�V���/�G�I�C�9�K�P�I���C�F�F�U���C���H�Q�W�T���E�J�C�T�C�E�V�G�T�� 
�U�G�X�G�P���U�G�I�O�G�P�V���F�K�U�R�N�C�[�����C���8�)�#���R�Q�T�V�����C�W�F�K�Q���L�C�E�M�����������D�K�V��
�G�K�I�J�V���E�J�C�P�P�G�N���5�2�+���#�&�%�����’�X�G���F�K�T�G�E�V�K�Q�P���O�K�E�T�Q���L�Q�[�U�V�K�E�M����
�G�K�I�J�V���.�'�&�U���C�P�F���G�K�I�J�V���U�N�K�F�G���U�Y�K�V�E�J�G�U��
  �6�J�G���#�T�E�C�F�G���/�G�I�C�9�K�P�I���C�F�F�U���C���8�)�#���R�Q�T�V�����C���U�Q�W�P�F���L�C�E�M����
�2�5�������R�Q�T�V�U���C�P�F���V�Y�Q���&�$�������L�Q�[�U�V�K�E�M���R�Q�T�V�U���
�H�Q�T���%�Q�O�O�Q�F�Q�T�G��
�C�P�F���#�V�C�T�K���L�Q�[�U�V�K�E�M�U��������
  �6�J�G���4�G�V�T�Q�%�C�F�G���/�G�I�C�9�K�P�I���C�F�F�U���V�Y�Q���U�V�G�T�G�Q���C�W�F�K�Q���L�C�E�M�U����
�/�+�&�+���K�P�����Q�W�V���C�P�F���V�J�T�Q�W�I�J�����O�K�E�T�Q�5�&���E�C�T�F�����O�K�E�T�Q���L�Q�[�U�V�K�E�M����
���Z�������E�J�C�T�C�E�V�G�T���.�%�&���F�K�U�R�N�C�[�����������C�P�C�N�Q�I�W�G���K�P�R�W�V�U���C�P�F��������
digital inputs.
�6�J�G���’�T�U�V���Q�H���V�J�G�U�G���K�U���F�G�U�K�I�P�G�F���H�Q�T���R�G�Q�R�N�G���Y�J�Q���Y�C�P�V���V�Q��

explore the general possibilities of the Papilio while the 
second and third provide functions for Arcade machines 
and music synths respectively. There are also a wide range 
�Q�H���U�K�P�I�N�G���H�W�P�E�V�K�Q�P���Y�K�P�I�U���C�X�C�K�N�C�D�N�G�����*�G�C�F���V�Q�� 
www.gadgetfactory.net/papilio to see all the options.
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things in addition to the ZPU and the output pins: a 
YM2149, a sigma-delta DAC and an Audio splitter. The 
fi rst takes the data fi le and converts it into audio data, 
the second takes the audio data and creates the 
signal, and the fi nal one takes a mono audio signal 
and splits it so that it works with stereo headphones.

The ZPU has 10 empty wishbone slots. These are 
the places that additional peripherals can connect to 
the wishbone bus of the processor. In this example, 
the YM2149 is connected to wishbone slot 5. This is 
set up in the code with:
ymplayer.setup(&ym2149,5); 

The program then reads data from the SmallFS 
fi lesystem. This is included as part of the sketch that’s 
uploaded, and it contains the fi les in the smallfs folder 
in the sketch folder (these are saved in sketchbook in 
your home directory). If you have other YMD music 
fi les, you can put these in there, and play them, though 
there’s not much space. ZAP does come with one 
that’s loaded by default called 
music.ymd.

Add-on bits of Papilio hardware are known as 
wings, and these slot directly into the headers on the 
board. There are a few available; because the FPGA 
can be reconfi gured to include any driver hardware, 

most of the wings are simple connectors to the 
hardware (sometimes with a high- or low-pass fi lter). 
This sketch is designed to work with an audio wing 
that includes a low-pass fi lter and an audio jack. 
However, this isn’t essential. It is possible to connect a 
speaker directly between the output pins and the 
ground (though it’s best to add a 220Ω resistor to 
prevent too much current being drawn).

The speaker should be connected to pin 8 on the 
side with the single strip of connectors (CL 0).

With this in place, upload everything to the Papilio 
as you did before. First, click on the appropriate BIT 
fi le link, and once this has fi nished, click on the icon to 
upload the sketch. You should hear the music playing. 
If it’s a bit quiet, you can increase the volume by 
changing 11 to 15 in the following lines:
ym2149.V1.setVolume(15);
ym2149.V2.setVolume(15);
ym2149.V3.setVolume(15);

You’ll need to reupload the sketch for this change to 
take effect.

You can’t arrest me, I’m a rock star
You may have noticed that there are also examples to 
play Atari MOD fi les and Commodore SID fi les. 
However, these are too big to fi t on the Papilio One. If 
you want to use an FPGA to emulate audio chips, the 
Papilio Pro is a better choice because it has more 
space for these more complex designs.

In the next example, we’ll keep going with music, 
but steer away from these more complex designs. 
Instead, let’s get back to basics with a sine wave 
generator. The one included with ZAP is designed for 
testing circuits, but it also works for generating tones.

In ZAP, go to Papilio > Papilio Examples > Bency_
Waveform_Generator to open the sample project, then 
go to File > Save As to create a copy.

The software is set up to generate a sine wave at 
2.4 MHz, which is a far higher frequency than humans 
can hear, so before uploading it, you’ll need to change 
this to something a little more audible. Let’s go for 
middle C (or 261.6Hz). Change the line in setup() to:
  setFreq(0.0002616); 

Burn the bit fi le to the FPGA, then upload the sketch. 
You should have a nice clean tone that gets a 
annoying after a while. To make the tone a little more 
interesting, we can add a slight vibrato effect by 
changing the sketch to the following:
#defi ne MYBASE IO_SLOT(5)
#defi ne MYREG(x) REGISTER(MYBASE,x)

float frequency=      0.0002616;
float frequencyStep = 0.0000002;
int numberOfWarbles = 10;

void setup() {  
  setFreq(frequency);  
}

void setFreq(float freq) 

Designing chips
In this tutorial we’ve only looked at using designs that 
have already been made and compiled for the Papilio. It is 
possible to create your own and upload these. If you want 
to understand what’s going on at a deep level, there’s a free 
book on the Spartan E3 (the FPGA in the Papilio) and VHDL 
(a hardware defi nition language) on GitHub at 
https://github.com/hamsternz/IntroToSpartanFPGABook.

Alternatively, The Gadget Factory has produced a 
schematics library. This enables you to work at a much 
higher level and link together components such as the sine 
wave generator. It is still quite technical, but easier than 
working with raw VHDL. There are some video tutorials on 
their website to help you get started: www.gadgetfactory.
net/learn.

Figure 1. These pulldown 
resistors ensure that the 
pin reads low when the 
button isn’t pressed.

To positive voltage

To ground

To input pin

R1
6.8kΩ
±5%

R2
220Ω
±5%
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{
  unsigned long long phase = freq * 44507433.119;
  MYREG(0) = phase;
}

void loop() {
  for(int i=1;i<numberOfWarbles;i++){
    setFreq(frequency + frequencyStep*i);
    delay(10);
  }
  
}

Most of this is taken from the example sketch, with 
just a little added to take some values out to variables 
(to make them easier to change), and a for loop that 
changes the frequency slightly. This will vary the 
frequency by gradually increasing it, then dropping it 
back down. A more sophisticated version would also 
drop the frequency back down gradually, but we’ll 
leave that up to you to implement.

This produces a slightly more interesting tone, but it 
still just keeps playing it on and on.

The ZPU has plenty of input/output pins that we 
can use, and the ZAP environment gives us a way of 
controlling the sine wave generator based on these 
inputs. We’re going to use this to create a simple 
keyboard. To save space, we’ll only use five keys (four 
to play notes and one to control the vibrato), but you 
can use the same techniques to build up to a more 
complex instrument. The banks of IO pins are handily 
arranged in blocks of eight, and five of them are 
completely free (three of the sixth are used up by the 
wave form generator, but the remaining ones could be 
used for control).

The code is similar to the example above, with some 
input pins set up, and some if statement to control the 
variables depending on which ones are pressed.
#define MYBASE IO_SLOT(5)
#define MYREG(x) REGISTER(MYBASE,x)

float frequency = 0.0;
float freqC = 0.0002616;
float freqD = 0.0002936;
float freqE = 0.0003296;
float freqF = 0.0003492;
float frequencyStep = 0.0000002;
int numberOfWarbles = 10;

void setup() {
  // put your setup code here, to run once:
  pinMode(0, INPUT); 
  pinMode(1, INPUT); 
  pinMode(2, INPUT); 
  pinMode(3, INPUT); 
  pinMode(4, INPUT);
  setFreq(frequency);  //Sets in Mhz
}

void setFreq(float freq)  //sets in Mhz
{

  unsigned long long phase = freq * 44507433.119;
  MYREG(0) = phase;
}
void loop() {
  // put your main code here, to run repeatedly:
  for(int i=1;i<numberOfWarbles;i++){
    setFreq(frequency + frequencyStep*i);
    delay(10);
  }
  frequency = 0.0;
  if(digitalRead(0)==HIGH){ frequency = freqC; }
  if(digitalRead(1)==HIGH){ frequency = freqD; }
  if(digitalRead(2)==HIGH){ frequency = freqE; }
  if(digitalRead(3)==HIGH){ frequency = freqF; }
  frequencyStep = 0.0000002;
  if(digitalRead(4)==HIGH){ frequencyStep =  0.000002;}  
}

The buttons can’t be directly connected to the pins, 
as they need a pair of resistors in order to correctly 
control the voltages. See figure 1 for details of how 
these should be connected. The five input pins on the 
Papilio are in the middle row at the bottom of the pin 
bank on the right-hand side  if you hold the Papilio 
with the USB port facing upwards.

We haven’t even scratched the surface of what’s 
possible with the Papilio and other FPGAs. The ability 
to create custom hardware in chips enables you to 
easily create things that are quite difficult with 
microcontollers, and this is only one use for them. At 
the moment the library of components to go into your 
designs is still quite small, but it’s already exciting. As 
they become more popular with the hobbyist 
community, you can expect to see a growing range of 
easy-to-use schematics. 

Our little synth will 
probably never produce 
any top 10 hits, but it has a 
sound unique to us. 

Just in case you missed it, harware wrangler Ben has written 
a book about Learning Python with the Raspberry Pi. It’s 
called Learning Python With Raspberry Pi.
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When sending data across a network or 
storing it on disk drives, there’s a chance 
that the data will become corrupted. Good 

hardware design can help minimise this, but it can 
never eliminate it completely, so it’s important to be 
able to detect when these errors happen so that the 
data can be re-sent.

The easiest way to check for errors is to add a parity 
bit. This is an extra bit of data added after each small 
block that’s used to detect errors. There are two types 
of parity: odd and even. In odd parity, the bit is used to 
make it so there is an odd number of 1’s in the data, 
while even parity makes it an even number of 1’s. 
When checking the data, the computer just counts the 
number of 1’s and sees if it matches with the type of 
parity being used.

For example, the letters LV are 01001100 
01010110 in ASCII. With an even parity bit added to 
each letter, they become 010011001 010101100. 
This adds one bit for every eight bytes of data, so 
there is more to send; however, in many cases it’ll be 
a good trade off because there’ll be fewer errors. This 
extra data is known as redundancy because it doesn’t 
add any information (we still only have the letters LV, 

but we’ve sent 18 
bits rather than 16).

A parity bit won’t 
detect every error. 
If any single bit 
gets flipped then 
it will flag it up, but 

if two bits get flipped, it won’t detect the error. It will 
detect an odd number of errors in the data, but not an 
even number of errors. You could increase the error 
detection by using a parity bit on a smaller piece of 
data. For example, you could split the above data into 
four-bit chunks and add a parity bit on these. This 
will improve the error detection, but at the expense 
of extra redundancy. The best trade off between the 
these two opposing forces will depend on how error-
prone the communications channel is.

Error correction
There are other ways than just splitting the data up 
into ever smaller chunks. One common way is to add 
three parity bits for every four bits on data. In this 
case, the parity bits (p1, p2 and p3) are interspersed 
so that they only cover some of the four data bits (d1, 
d2, d3 and d4). 

  p1 is calculated based on even parity with data bits 
d1, d2 and d4.
  p2 is calculated based on even parity with data bits 
d1, d3 and d4.
  p3 is calculated based on even parity with data bits 
d2, d3 and d4.
The data is sent in the order p1,p2,d1,p3,d2,d3,d4.
By interlacing the parity bits in this way, you can 

not only tell that an error occurred, but which bit it 
occurred in. For example, if p1 and p2 are incorrect, 
but p2 is correct, then you know that the error must 
be in d2 (or there is more than one error). This 
means that if you are reasonably confident that the 
communications channel won’t flip more than one 
bit out of every 7, you can correct any single-bit error. 
On the other hand, if it’s a noisy channel, you can 
detect any two-bit errors (these would be corrected 
incorrectly if you dealt with them as single-bit errors).

Stop: Hamming time
This is known as a 7,4 Hamming code, because the 
method was developed by Richard Hamming, and for 
every 7 bits set, 4 are data.

The reason we know how many bits can be 
corrected or detected by a particular code is because 
of the Hamming distance. This is the number of bits 
that have to flip to get from one valid sequence to 
another. For example, using the 7,4 hamming code, 
1111 and 0111 are encoded as:
1,1,1,1,1,1,1
0,0,0,1,1,1,1

You can see that at least three bits have to flip 
to get from one to the other. If you calculate 7,4 
Hamming codes for all possible values of d1,d2,d3 
and d4, you’ll find that this is the minimum number 
of bits different between any two, so we can say 
that it has a minimum Hamming distance of three. 
Whenever there is a single-bit error, it will be closer to 
one code than the other. However, if there are two-bit 
errors, then it will be closer to the wrong code.

If you want to detect or correct more errors, then 
you need to increase the Hamming distance. Again, 
this means increasing the redundancy. It turns out 
that this is easily done by adding a parity bit that 
covers every bit (p1–p3 and d1–d4). The result is 
a code that has four bits of data for every eight bits 
sent and a minimum Hamming distance of four (this 
is an 8,4 Hamming code). This can still only correct 
a single-bit error, but it can detect three bit errors in a 

ERROR DETECTION WITH 
HAMMING CODES AND CRCs
Data errors are a fact of life, but with a little clever code,  
you can catch them out before they trip you up.

CODING TUTORIAL

BEN EVERARD
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“A parity bit is an extra bit of data 
added after each small block, 
which is used to detect errors.”
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p2 d1
p1

d4

d3 d2

p3

single block. A 9,4 Hamming code would be needed to 
correct two-bit errors. It is possible to go on building 
codes with more and more redundancy that can 
detect and correct more and more errors. However, 
the more bits you add, the more you have to send, and 
so the less data you can get through the channel. 

Cyclic codes
Hamming codes are good for detecting errors in very 
noisy channels, but other times we want a solution 
that’s very quick to calculate and that doesn’t have too 
much redundancy. In this case, we may use Cyclic 
Redundancy Checks (CRCs). The mathematics of 
why these work is a little complex, but in practice, they 
are a little like long division using XOR, and the 
remainder is the redundancy used to check that the 
received value is correct. Let’s look at an example 
using the coefficient 1011 on the data 01001100 (the 
letter L in ASCII) and a three-bit CRC.
01001100 000   data (trailing 0s are the 3 bits for the CRC)

1011                 divisor aligned with the first 1
00010100 000   result of XOR
   1011                 divisor aligned with the first 1
00000010 000   result of XOR

10 11     divisor aligned with the first 1
00000000 110   result of XOR
The CRC finishes because the result is all zeros except 
for the three bits that form the CRC value (110). 

To reverse the CRC, the full data is run through the 
same process, except that the CRC value takes the 
place of the trailing zeros. At the end, if the remainder 
is 0 then the CRC data is correct; otherwise there is an 
error in the data (we’ll leave it up to you to perform this 
and check that the above value is correct). 

CRCs don’t help you fix the error in the same way 
that Hamming codes do, they just try to spot them. 
CRCs can also be designed to be longer or shorter, 
and the length will make them better or worse at 
finding errors.

The reason this is very efficient to implement in 
hardware is that it can be done with little more than 
a shift register and a few logic gates. This is far less 
than what is needed for Hamming codes. Because 
of this simplified requirement, it can run in real time 
even on very fast data transfer, and you’ll find CRCs 
in everything from CDs and DVDs to Ethernet and 3G 
mobile networks. 

The outside world is a scary place for data. There is 
all manner of electromagnetic interference and other 
problems just waiting to flip 0s into 1s. With a little 
careful planning, though, we can protect our precious 
digits and make sure they don’t come to any harm. 

A Venn diagram like this one can be 
used to work out which bit is in error 

in a 7,4 Hamming code. The three 
circles represent the parity bits, and 
the error is the data bit that’s within 

all of the circles of the parity bits 
showing errors, but not inside the 

circle of the parity bit not showing 
errors (if there is one).
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Ben Everard is the best-selling co-author of the best-selling 
Learning Python With Raspberry Pi.
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Android’s success is colossal. It’s the most 
widely distributed version of a Linux-based 
operating system, used on everything from 

smartphones and tablets to cars, fridges and air 
conditioning units. It’s only a matter of time before it 
reaches your toaster. And while it may have started 
life outside of Google as an advanced operating 
system for digital cameras,  Google’s purchase of 
Android, Inc. in 2005 slotted Android into Google’s 
plans for mobile world domination, inadvertently 
making it the operating system for the touchscreen 
generation – the opposite of Apple’s iOS, with all its 
walled garden and hardware consistency. Android is 
wild, chaotic, uncountable and outgrowing itself. But 
it’s also open source and still relatively open. You don’t 
need to pay Google to write software for it, and you 
don’t need to root your device to run your applications. 
Despite an unwieldy API and a huge boilerplate of 

DEVELOP YOUR FIRST 
ANDROID APPLICATION
Google’s Android Studio has made Android development more 
straightforward than ever. As we prove. Kind of…

CODING TUTORIAL

GRAHAM MORRISON
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requirements for running your own applications, 
development isn’t even that diffi cult – especially if you 
just want to hack your own solutions into the chaos. 
Which is exactly what we’re going to do here, in what 
will be the fi rst part of a series on creating a Linux 
Voice application for Android. 

We’re going to start modestly. We’ll build a very 
simple RSS reader app that will parse the latest posts 
from LinuxVoice.com and enable you to select a story 
to open in a browser. As a starting point, we may then 
expand upon this simple application to create a much 
more functional application. But it’s also a perfect 
way to acclimatise yourself to Android development, 
and from there, put your own ideas into code. And 
because we’re embracing all things cutting-edge and 
chaotic in this tutorial, we’re going to use this as an 
excuse to try Google’s own Android development 
environment – Android Studio.

It’s worth updating Android Studio frequently, as each 
update makes the environment more stable.

INSTALLATION

Android Studio exists solely for Android applications. 
It ties itself seamlessly with the Android SDK and the 
emulator tools used to test your code, and also offers 
cutting-edge shortcuts for writing. There’s WYSIWYG 
realtime app rendering, a UI designer, Android 
templates and an editor that spots mistakes as they 
happen. But its cutting edge nature also means it’s 
unstable, and Google doesn’t yet recommend it for 
use in mission-critical development. That’s not going 
to affect us as we take our preliminary steps in 
Android development, but it’s something to consider 
when your app development ambitions take you 
further than a simple RSS reader. 

Android Studio is based upon another IDE, IntelliJ 
IDEA, and as you might have inferred by the mention 
of Eclipse and IntelliJ IDEA – two IDEs written in Java, 
Android is all about the Java. Java is something of a 
contentious language even now,  but there’s no 
denying its ubiquity. More importantly, as long as 
you’ve some previous experience in an object-oriented 
environment, Java is legible and easy to understand 
and get along with. It’s a good choice for a hacker-
friendly tutorial. 

We installed Android Studio on both Arch Linux and 
Linux Mint/Ubuntu. Arch packages are held in the user 
repository, while manual installation is also relatively 
straightforward: just download and execute a binary. 

1

However, we fi nd installation on Mint an easier 
proposition as it automatically deals with 
dependencies and the environmental variables 
required by Android Studio to fi nd the SDK (which also 
needs to be installed manually). To install from 
Ubuntu or Mint, just type the following:
sudo apt-add-repository ppa:paolorotolo/android-studio
sudo apt-get update
sudo apt-get install android-studio

This should grab over 650MB of data, as the 
download includes the SDK alongside the 
development environment and any dependencies 
you’ve yet to install. But it will leave you with a full 
development environment capable of building 

WHY DO THIS?
•  Develop for a hugely 

successful platform
•  Get into the Android app 

store and make £$€
•  Never miss another 

Linux Voice podcast
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PRO TIP
When using ‘try’ and 
‘catch’, debugging is much 
easier if you isolate each 
exception rather than 
grouping them together 
(as we have).

The Android Studio New 
Project wizard creates 
sensible defaults for nearly 
all values. 

DEVICE CONSIDERATIONS
From the ‘Welcome to Android Studio’ window, click 
on ‘New Project’ to start our adventure. We’ve now got 
to change a few values in the next window that 
appears. The app needs a name, and we called ours 
simply ‘Linux Voice’. We’ll also need a package name, 
which needs to adhere to Java’s package naming 
convention. Recent versions of Android Studio will 
automatically create this from your application name, 
but if you need to change this to something that 
closer matches your own confi guration, make sure it 
uses the reverse hierarchical naming pattern, normally 
(but not always) linked to the top level domain of your 
organisation plus the name of your app.

The next three fi elds ask you which version of the 
SDK you want to build your application against. 
Android has changed a lot over the years, and many 
of its more advanced features are only available in the 
4.x SDK. But while choosing the latest SDK is the 
easiest option, the best answer is going to depend on 
what capabilities you want your application to have 
and where you want it to be used. Unlike iOS, many 
Android users can’t simply update their devices to the 
latest releases. Many manufacturers don’t even 
provide updates, and even when they do offer 
updates, they’ve usually made so many modifi cations 
to Android themselves that it takes many months for 
an update to be distributed. The result is that there are 
many different versions of Android in active use. 

Choose your platform
Google uses statistics gathered from its Google Play 
app to report on the devices accessing the store over 
the previous seven days, so that developers can make 
their own judgment on which platforms to target. 
We’ve printed the table from early April, and you can 
see that while a signifi cant percentage of devices are 

2

using a 4.x version of Android, there’s still almost a 
fi fth of all Android devices running Gingerbread. We 
decided with setting a minimum required SDK of 14 
(Ice Cream Sandwich), while setting the target and 
compile SDK at the very latest version, 19 (Kit Kat). 

You can leave the other options at their default 
values – just make sure that ‘Create Activity’ is 
enabled, as this adds the next page to the New Project 
wizard, which enables you to select which kind of 
template to use for your project. These are worth 
exploring, as each example will include the best 
practice for different elements of a typical Android app, 
and each new version of Android Studio includes 
more. But for our fi rst application, we’re going to keep 
things simple and go with the ‘Blank Activity’. This lets 
us build things up from scratch but also avoids too 
many complex concepts that come with more 
complex templates. After selecting the blank template, 
the fi nal page is where we give our activity a name. 

An activity is what Android calls the application 
component that expects something of the user. For 
nearly every instance, that means putting something 
on the screen you can interact with. Android likes to 
break down the functional components within an 
application, and an activity is one such component, 
usually with one purpose. It could be a web browser, or 
a music player, but equally, it could be a stream of RSS 
stories, which is the only activity our application is 
going to provide.  An application is then a combination 
of multiple activities tied together to create a fully 
functional tool.  Having said that, you can leave the 
Activity and Layout names at their default values, as 
they make only a cosmetic difference.

Current Android versions
Version Codename API Distribution
2.2 Froyo 8 1.1%
2.3.3 -2.3.7 Gingerbread 10 17.8%
3.2 Honeycomb 13 0.1%
4.0.3 -4.0.4 Ice Cream Sandwich 15 14.3%
4.1.x Jelly Bean 16 34.4%
4.2.x  17 18.1%
4.3  18 8.9%
4.4 KitKat 19 5.3%

projects that can run on your desktop through an 
emulator and deployed to your own Android devices. 
Android Studio can be started by typing android-
studio on the command line, or through an icon 
embedded within your desktop’s launch menu, and 
the fi rst thing we’d recommend you do after the 
splash screen has gone is to ignore the ‘Welcome to 
Android Studio’ window, and instead open the small 
‘Check For Updates’ link in the windows bottom 

border. After checking against the server, the 
application will almost certainly announce that there’s 
an update that can be installed, and unlike other 
applications installed through a distribution, in-place 
updates to Android Studio work. Just let the 
application run and update itself. Android Studio is in a 
rapid state of development, so it’s a good idea to keep 
on top of updates. There are usually one or two per 
month, and recent updates have been very stable. 

LV004 104 Code Android.indd   105 08/05/2014   12:43



CODING ANDROID

www.linuxvoice.com106

PRO TIP
Android Studio’s editor 
will grey-out lines, such 
as imports, if they’re 
redundant, and even make 
suggestions for spelling 
corrections.

TESTING YOUR ENVIRONMENT

With a device added to the device list, you just need to 
click on Launch to run the instance. However… stop! 
On most displays, a running Android instance takes 
up nearly all your screen space, because of the 
high-DPI values on most Android devices. A Nexus 5, 
for example, has a screen resolution of 1920x1080 
pixels, which is more pixels that many screens are 
capable of displaying. We’ve not found a way of 
scaling the emulator from the launcher, but you can 
scale the emulator from the command line. For that 
reason, we’d recommend running it from there. If the 
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You can run almost any real and functional Android 
device from the Android Virtual Device manager.

ANDROID EMULATION

This is where we hit some cutting-edge turbulence. 
With Android Studio 0.5.7, the template generated an 
error before we’d even got to the code. The error 
console complains that the Android Support 
Repository isn’t installed. And while this was indeed 
installed, any update required another update to push 
the Support Repository version up from 4 to 5. To fi x 
this, we needed to open one of several support tools 
used to augment the Android development 
environment – the Android SDK Manager. This can be 
opened from the Tools > Android menu, and when 
opened it lists the various SDKs and tools installed 
alongside Android Studio. We needed to allow this to 
update two packages, which it did automatically after 
accepting a couple of licences from Google. Hopefully, 
you won’t have to go through a similar process when 
you fi rst start Android Studio. 

Before we spend a little time going through Studio’s 
GUI components, fi rst click on the Play button in the 
toolbar at the top of the window. This will build and 
attempt to launch the template, which is itself a fully 
executable application. Most of the few seconds 
it takes is spent launching the Android Debug 
Bridge, ADB, which is a tool that grabs runtime and 
debugging information from a runtime instance of 
your application, whether it’s running on an emulator 
or on a real device. 

Android emulator
The next window that appears lets you select which 
device you want to run your application on. The 
Android Emulator is one of the most useful tools 
for both Eclipse and Android Studio development, 
as it enables you to run your code on a fully fledged 
Android device, albeit one being emulated in software. 
This does affect performance, but it also means 
you can spin up any kind of device you want, from 
old models using an ancient version of the SDK, to 
models with resolutions and hardware combinations 
that don’t get exist, and you don’t have to spend any 
money getting the latest devices. From the ‘Choose 
Device’ window, make sure ‘Launch Emulator’ is 
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selected and click on the ‘Expand’ button to the right 
of the drop-down list. This will open AVD – the Android 
Virtual Device manager. 

This is the tool that manages your real and fi ctitious 
virtual Android devices, and to get started you need 
to click on the ‘Device Defi nitions’ tab. This page 
lists common defi nitions for a device, and clicking 
on ‘AVD’ will create an instance for you to run. If you 
want to edit any of these settings, you’ll need to clone 
a defi nition fi rst. This will allow you to adjust things 
such as the native resolution of a device, or whether 
both portrait and landscape modes are available. 
After you’ve added a device to create an AVD, you can 
edit runtime options such as the amount of internal 
story available to the emulation, whether an instance 
is persistent (storing the data between sessions), or 
whether graphics calls use your real machine’s GPU, 
as well as the target level of the SDK. 

If you’ve got the correct packages installed, you 
can also switch between the much slower ARM CPU 
emulation to the x86 instruction set of your native 
system. This gives a big performance boost and 
won’t cause any compatibility issues unless you’re 
performing more complex or low-level operations. 
We opted for a clone of the Nexus 4 profi le with no 
other modifi cations. 

Android tools have been added to your path, it can be 
run with the emulator command; if not, you’ll need to 
fi nd it yourself. Arch installs the SDK into the /opt 
folder, while the PPA packages for Ubuntu and Mint 
install themselves into /usr/share/android-studio/
data/sdk/. And because your own copies of the AVD 
profi les are copied to your home folder, you can 
reference them directly from the emulator command. 
To run the emulator at 50% resolution, which we’ve 
found perfectly acceptable, type the following, 
replacing the name of the virtual device with the AVD 
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Create a new class within Studio by right-clicking on the 
main activity source fi le.

LET’S START CODING!
Before we start with the code specifi cs, we need to 
allow our application to access the internet (on the 
device you eventually run it on). Think of this being the 
Android equivalent to SELinux, and all such control is 
governed by a single fi le found in the root directory of 
your project – AndroidManifest.xml. This fi le controls 
access and permissions as well as what can and can’t 
be received by the various activities that make up your 
application. You can edit it in Android Studio from the 
project hierarchy view on the left, by clicking on the 
project name, ‘app’ then ‘src’. You need to add the 
following before the ‘<application’ tag, as this ensures 
accesses to the entire package:
 <uses-permission android:name=”android.permission.
INTERNET” />

With that line edited, we can now start with our 
own code. The fi rst thing we want is a method to 
grab and parse the RSS provided by our site, and as 
this is such a common requirement, many people 
have already solved this problem in lots of different 
ways. The most straightforward we found was written 
by Tony Owen (http://droidapp.co.uk) and used 
in several open source projects, including the now 
rather old rpdroid podcasting client. Tony offloads 
RSS handling into its own Java class, and we’ll do a 
similar thing. To create a new class, follow the path 
hierarchy in Android Studio down through src, main, 
Java and your package name. You should already 
have a single activity called ‘MainActivity’, unless you 
changed this in the startup wizard. MainActivity is 
where all the action is happening, and where you can 
quickly augment the “Hello World” app with your own 
features. 

To create a new class (which will be contained 
within its own ‘Java’ fi le), right click on MainActivity 
and  select ‘New > Java Class’. In the small window 
that appears, enter a new class name – we used 
‘dataRSS’, but as long as you’re consistent within 
the application, it won’t matter which name you 
choose. You’ll then see the new class listed beneath 
MainActivity, with the text editor waiting for your 
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inspiration. This class is going to be very simple, with 
no methods to do calculations and only four variables 
– three to hold the string parts of the RSS feed we 
want to pass back to MainActivity, and a single integer 
to keep the list location of the eventual post when 
it appears in our application. The only peculiarity, if 
you’re not used to Java, is that our strings are arrays 
that we don’t have to give a size to until we initialise 
them later:
public class dataRSS {
    public static String[] postTitle;
    public static String[] postURL;
    public static String[] postContent;
    public static int position;
}

We’re going to follow this with the only other class 
we’re going to write, a class we’ve called parseRSS, 
which should be created the same way we created 
dataRSS. This will contain the method that will 
download and parse the bits we want from the RSS 
fi le, so it’s going to be slightly more complex. Let’s go 
through the code, starting with the fi rst few lines:
public class parseRSS {
    public static void parse() {
        URL url;

name listed in the AVD manager:
emulator -scale 0.5 @AVD_for_Nexus_4
The emulator window will appear at the proper scale 
and proceed to load Android. This can take a minute 
or two if you’re emulating an ARM CPU, but speed 
obviously depends on your system. Before too long, 
you should have a working Android system that you 
can unlock by sliding the padlock to the right with a 
click of the mouse. 

You should also be able to go back to the ‘Choose 
Device’ window from Android Studio and see the 
running instance listed beneath the ‘Choose A 
Running Device’ button, which should be enabled. 
To run your application, select the running device 
from the list and click on OK. We’d also suggest you 

enable the ‘Use Same Device For Future Launches’ 
so that you don’t have to go through this step again - 
although this only works for the current session. 

A few moments later, your virtual Android device 
should burst into life and your application will run 
automatically. This is the default testing environment, 
and if you take a look back in Android Studio, you 
should see that it’s in constant contact with the 
emulator. When you start debugging or monitoring 
your application, you’ll be able to break execution and 
watch variables across the Android Debug Bridge 
exactly as you could if the application was running 
natively on your desktop. If everything is working 
correctly, you should see the ubiquitous “Hello world” 
staring back at you, and it’s now time to start coding. 

LV004 104 Code Android.indd   107 08/05/2014   12:43



CODING ANDROID

www.linuxvoice.com108

All our import 
lines were 
automatically 
added via 
Android 
Studio’s 
auto-complete 
features.

MAKING A CONNECTION
The last line in the previous snippet is try, and it’s one 
of Java’s most useful functions. It’s an exception 
handler that forces us to deal with the consequences 
of something not happening rather than allowing the 
app to crash. The situations dealt with by try will be 
dealt with by a catch instruction later on in the code.

In the next two lines, we’ll give url the address of our 
feed and ask Java to open a connection:
 url = new URL(“http://www.linuxvoice.com/feed”);
 HttpURLConnection conn = (HttpURLConnection) url.
openConnection();

If the connection can be made successfully, our 
application will get past the following ‘if’ statement, 
taking us into the section of code that deals with the 
nitty gritty of the XML within the RSS feed. There are 
many ways to deal with RSS/XML, but we’ve found 
the easiest to be DocumentBuilder, which provides an 
API to access the tree layout of an XML file. In the 
following code you’ll see that we set up a few 
variables before structures for getting to the data 
within the data stream before db.parse(url.
openStream()) passes control of the data to the 
variable we call doc. We’ll also initialise the arrays we 
created in the dataRSS class using the size of the list 
gleaned from the RSS and now held in itemLst:
if (conn.getResponseCode() == HttpURLConnection.HTTP_OK) {
  DocumentBuilderFactory dbf = DocumentBuilderFactory.
newInstance();
  DocumentBuilder db = dbf.newDocumentBuilder();
  Document doc;
  doc = db.parse(url.openStream());
  doc.getDocumentElement().normalize();
  NodeList itemLst = doc.getElementsByTagName(“item”);
  dataRSS.postTitle = new String[itemLst.getLength()];
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  dataRSS.postURL = new String[itemLst.getLength()];
  dataRSS.postContent = new String[itemLst.getLength()];

We’re now going to go through itemLst using a ‘for’ 
loop and attempt to assign the contents of the 
elements referred to by the tag names ‘title’, ‘link’ and 
‘content:encoded’  by passing them to NodeList 
elements, which is simply a collection of nodes we 
hope will contain the data we’re after.
for (int i = 0; i < itemLst.getLength(); i++) {
  Node item = itemLst.item(i);
  if (item.getNodeType() == Node.ELEMENT_NODE) {
    Element ielem = (Element) item;
    NodeList title = ielem.getElementsByTagName(“title”);
    NodeList link = ielem.getElementsByTagName(“link”);
    NodeList content = ielem.getElementsByTagName(“content:en
coded”);

Because we can’t be certain that the data we’re 
after will be contained within the title, link and content 
NodeLists we’ve created, we’ll need some exception 
handling again with try as we attempt to assign the 
values from the RSS to the string arrays we created:
try {
  dataRSS.postTitle[i] = title.item(0).getChildNodes().item(0).
getNodeValue();
  dataRSS.postURL[i] = link.item(0).getChildNodes().item(0).
getNodeValue();
  dataRSS.postContent[i] = content.item(0).getChildNodes().
item(0).getNodeValue();
} catch (NullPointerException e) {
     e.printStackTrace();
}  

In the previous piece of code, you’ll see that we’ve 
included the catch block for dealing with the 
exception. As you might expect, all this does is output 
the methods (the stack trace) of the application that 
have led to this point, and we’ll finish of the class with 
closure on the previous try as well as close brackets 
for all the other blocks. We’ve put these on the same 
lines for brevity, as you should be properly indenting 
your code or getting Android Studio to do it for you 
(Code > Reformat Code in the menu):
}  }  }
} catch (Exception e) {
  e.printStackTrace();
}  }  }

        try {
All we’re doing is creating the class and adding a 

single method, which is the function we’re going to 
call to process the RSS. You should notice that as you 
add ‘URL’, it gets highlighted in red. This is because 
the Java compiler can’t find any other reference. Hold 
the cursor over the URL characters and the editor 
will complain it can’t resolve the symbol. The editor 
in Android Studio is smart and can make lots of 
intelligent calls when spotting and fixing errors. If you 
now click the ‘URL’ text, the tooltop should say ‘Java.

net.URL? Alt + Enter’. The editor is saying that Java.
net.URL satisfies the resource and can be imported 
by pressing Alt + Enter. If you do this, a popup menu 
will open and the first option will allow you to import 
the class, and selecting that will add ‘import java.
net.URL;’ to the top of the file and solve the error. For 
this reason, we haven’t included any of the ‘import’ 
statements for our code, as you should be able to 
add them yourself (and it saves space). If you have 
problems working them out, download the project 
source code from LinuxVoice.com.
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Graham Morrison is the author of Kalbum, a photo collection 
manager that, in its heyday, was in the Mandriva repositories. 
Nowaday’s he’s best known for synthesizer music.

ADDING THE FUNCTIONALITY
We’re not going to spend much time on the GUI this 
month. All we’re going to do is replace the TextView 
widget with the ListView widget. ListViews are now 
synonymous with smartphones – they’re the bread 
and butter widget used to display everything from 
email to Tweets. And while Android Studio has a 
wonderful visual editor for creating your own user 
interfaces, the best way to accomplish this is to open 
the GUI resource in your Android project – app/src/
res/activity_main.xml in the project’s hierarchy. When 
you click on this file, Android Studio will switch to the 
visual editor, but you’ll need to switch from the ‘Design’ 
tab to the ‘Text’ tab to edit the XML file responsible for 
the layout directly. This view is still excellent, as it 
updates a virtual Android device of your choice, giving 
you the best of both worlds. To replace the TextView, 
simply paste over the entire block with the following:
   <ListView
        android:layout_width=”wrap_content”
        android:layout_height=”wrap_content”
        android:id=”@+id/listView”
        android:layout_gravity=”center_vertical”
        android:layout_weight=”1” />

The important thing to note here is that we’re calling 
the new widget listView, as referenced by the 
android:id tag. We’ll use this to reference the widget 
within our MainActivity code, and that’s going to be 
our next and final target for this tutorial, so double 
click on MainActivty.java and let’s make it so! 

Before we get onto the complete code for the main 
class, we’ve removed both of the methods that deal 
with the menu, because while they’re an essential part 
of the template for adding functionality, they’re only 
going to add complexity here.
public class MainActivity extends Activity {
parseRSS parserss;
@Override
protected void onCreate(Bundle savedInstanceState) {
  super.onCreate(savedInstanceState);
  setContentView(R.layout.activity_main);
  parserss = new parseRSS();
  new updateRSS().execute();  }

The above section of code is the beginning of our 
class. We create our own global parserss variable 
from the parseRSS method we created earlier – this 
should be important automatically because the Java 
class is in the same file as MainActivity. We then 
change the contents of the onCreate method that 
Android Studio creates automatically, adding the 
parserss activation and an execute() method call for a 
background processing class we haven’t created yet. 
The @Override annotation is already there, because 
this is a reimplementation of another method and we 
want to make sure Java executes our version instead.

The next stage is to write the method to add items 
to the ListView widget,  and to handle what happens 
when one of those items is clicked to add items to the 
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list. This is quite straightforward. We use 
findViewById to link the UI widget we laid out earlier 
with the ListView widget we create in code, and call 
this ‘storylist’. We’re then able to add elements via the 
setAdapter method. We’re just adding the title at the 
moment, but we use the URL in the next view lines. 
We need to create an even listener to deal with user 
input, and we use ListView’s setOnItemClickListener 
and the AdapterView.OnItemClickListener() to handle 
the callback, which then decodes which item has 
been pressed via our ‘position’ variable and starts a 
new activity based on the URL. If we linked to an audio 
file, Android would launch an audio player, but as we’re 
linking to a web page, it’s going to open the web 
browser. You’ll always be able to return to our app 
using the ‘back’ button.
public void populate_list() {
  ListView storylist;
  storylist = (ListView) findViewById(R.id.listView);
  storylist.setAdapter(new ArrayAdapter<String>(MainActivity.
this,     android.R.layout.simple_list_item_1, dataRSS.postTitle));
    storylist.setOnItemClickListener(new AdapterView.
OnItemClickListener() {
    public void onItemClick(AdapterView<?> parent, View v, int 
position, long id) {
    dataRSS.position = position;
    Uri uri = Uri.parse(dataRSS.postURL[dataRSS.position]);
    Intent intent = new Intent(Intent.ACTION_VIEW, uri);
    startActivity(intent);
  } }); }

The final chunk of code is the updateRSS method 
that we called execute() on earlier. It uses AsyncTask 
to show an update dialogue and stop our application 
from locking up whilst we update the RSS feed.
private class updateRSS extends AsyncTask<Void, Void, Void> 
implements DialogInterface.OnCancelListener {
    private ProgressDialog dialog;
    protected void onPreExecute() {
      dialog = ProgressDialog.show(MainActivity.this, “”, “Updating 
RSS. Please wait...”, true);     }
    protected Void doInBackground(Void... unused) {
      parserss.parse();
      return null;    }
    protected void onPostExecute(Void unused) {
      dialog.dismiss();
      populate_list();    }
    public void onCancel(DialogInterface dialog) {
      cancel(true);
      dialog.dismiss();
    }  }  }

And that’s it! Run the project and it should download 
our RSS feed. Click on a story and it will open it from 
your default browser. Let us know how you get on!  
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The VLC Media Player is a free and open-source 
multimedia player. There are a number of 
Linux media players to choose from but this 

one can play just about anything and will often 
succeed where other players fail.

But it is much more than just a media player. It was 
originally a pair of applications: the VideoLAN Client 
called vlc and the VideoLAN Server called vls. The 
client and server functionality are now both contained 
in a single application – the VLC Media Player, which 
everyone now refers to as VLC.

You can use VLC to encode videos in a similar way 
to the command-line tools that we looked at earlier 
and you can use it as a streaming server. But you’ll 
probably want to start by using it as a player.

Playlist
Central to VLC is its playlist, which is more than your 
typical playlist –you can create, load and save your 
own playlists, but what we have here is more of a 
gateway to content, both on your local network and 

VLC MEDIA PLAYER –  
THE ONE THAT DOES IT ALL
Play media, transcode files, stream live media and more with this ancient application.

on the internet. You can directly access media on your 
local machine, either its hard drive or DVD. If you plug 
in a media player that uses the Media Transfer 
Protocol (MTP) you can access its contents directly.

If you have any DLNA (Digital Living Network 
Alliance – we know, it sounds horrible) devices such 
as a PVR machine on your network, then you can also 
access their content through the playlist. DLNA is a 
media sharing standard offered on some internet-
ready audio-visual devices like televisions and PVRs, 
and it is a simplified subset of something called 
Universal Plug And Play, which VLC also supports. 
Opening the playlist (Ctrl+P) and selecting Universal 
Plug’n’Play will query the devices on the network (this 
may take some time) and then offer a list of content. 
Click on an item to play it. Other network services can 
be accessed in a similar way – VLC supports SAP, the 
Session Announcement Protocol, which gives access 
to published multicast services and Apple’s Bonjour 
protocol.

You can even directly access Freeview digital 
television broadcasts if you have a working TV card 
and know your local transmitter’s frequencies. Go to 
Media > Open Capture Device and select the TV – 
Digital capture mode. Enter the relevant frequency and 
press Play. Programme guide information is collected 
and you can view this with Tools > Program Guide.

Internet media
Beyond your local network and TV antenna, the 
internet is a rich source of media, and VLC gives easy 
access to internet radio sources like Icecast and 
Jamendo through the Internet choices on the Playlist 
screen. You can also add your own media favourites, 
such as your favourite Linux podcasts.

To add a podcast, go to View > Playlist, then click  
on Podcasts; the Plus sign opens a dialog where  
you can enter the URL for the podcast (for example, 
www.linuxvoice.com/podcast_opus.rss), giving you 

BEN EVERARD

JOHN LANE

Essential Linux tools explained – this month, the VLC media 
player and a trio of command line media tools

MASTERCLASS

VLC’s programme guide 
lets you see what’s on TV.
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direct access to all episodes of the podcast that the 
feed provides.

The default user interface fi ts in with your desktop 
environment, but VLC is skinnable, meaning that you 
can change its visual appearance. Many skins are 
offered at the VLC website, www.videolan.org/vlc/
skins.php, and you can even download them all at 
once like so:
mkdir -p ~/.local/share/vlc/skins2
curl http://www1.videolan.org/vlc/skins2/vlc-skins.zip | bsdtar 
-C ~/.local/share/vlc/skins2 -xvf-

You need to go to the Preferences page (Control+P) 
within VLC and set the Look And Feel to “Use Custom 
Skin” and then exit and re-start. You can then choose 
a skin by right-clicking Interface > Select Skin.

You can also choose a skin when starting VLC 
using the --skins2-last command-line option. You 
need the full path to the skin fi le:
vlc --skins2-last=~/.local/share/vlc/skins2/neon.vlt

Be aware, however, that using skins can hide some 
of VLC’s functions.

Broadcast yourself
Once you’re happy that you can play pretty much 
anything you want, you can move on to streaming, 
because VLC will stream anything that it can play. You 
can select anything from your playlist and stream it 
– just use the drop-down menu on the Play button to 
change it to Stream.

You’ll be walked through a set of screens where you 
specify what and how to stream – the protocol to use 
and any transcoding to perform. The fi rst screen 
defi nes what will be streamed, and you can fi ll this in 
yourself, but selecting from the playlist will fi ll it in for 
you. The second screen enables you to defi ne 
streaming destinations. These can be a fi le or one of 
several network profi les including HTTP and RTP (you 
can have more than one if you need to). You can also 
choose whether the streamed content is displayed 
locally so you can see what’s being streamed. 

The fourth screen is where you can enable 
transcoding, and there are several confi gurations to 
choose from. If none of those suit, you can create 
your own. Once the stream starts, you can view it 
from any player that can access it (another copy of 
VLC is an obvious choice here).

Streaming to a fi le enables you to record a live 
stream to your local machine. You can also save 
remote content locally, which is a good way to to take 
a copy of recordings from your PVR onto your 
computer. You can transcode while doing this if you 
want the copy in a different format to the original.

Your preference
We already mentioned how you can change the look 
and feel with custom skins. You can also change the 
behaviour with Preferences (Control+P). There are 
many options available here to change VLC’s 
behaviour, but it’s unlikely that you will need to change 
many of them. If you want to back up your 

preferences, they’re stored in a fi le: 
~/.confi g/vlc/vlcrc

One of the preferences controls the video output. 
It’s normally set to automatic but, for fun, try setting it 
to Color ASCII art video output. You need to re-start 
VLC after changing preferences but, once you’ve done 
this, any video played will be rendered using colour 
ASCII art. This isn’t much use unless you’ve only got a 
text terminal, but it’s fun nonetheless and just goes to 
show that VLC has many tricks up its sleeve.

You can use the command-line version of VLC to 
view a movie in any terminal window. Now you don’t 
even need a graphical desktop to watch things! (press 
Alt+F4 to quit.)
cvlc -V caca my_movie.mp4

No GUI needed
If you’re using VLC for downloading or streaming or 
you have another reason why you don’t need the full 
GUI experience then 
there is a command-line 
version called CVLC, 
which offers the same 
functionality but is driven 
through command-line 
options. This is its server 
heritage showing through, and CVLC enables you to 
use VLC for non-GUI applications such as setting up a 
streaming server or as a transcoding tool.

“Streaming to a fi le with VLC 
enables you to record a live 
stream to your local machine.”

Change VLC’s look and feel 
with a custom skin.

With VLC’s ASCII art, you 
can watch a movie on a 
terminal.
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As with most things Linux, there is a perplexing 
number of media tools available. Many of 
these are merely wrappers around a small 

number of utilities that perform the heavy lifting 
and the most common ones include Mencoder and 
FFmpeg, which we’re going to look at here.

Mencoder comes from the same stable as the 
MPlayer media player, and it enables audio and video 
files to be decoded, filtered and re-encoded. As it’s 
built from the same codebase as MPlayer, if MPlayer 
can play it, Mencoder can decode it.

FFmpeg is a collection of tools and libraries for 
encoding, decoding and streaming audio and video. 
It includes the libavcodec library, which is widely used 
by other packages including Mencoder. FFmpeg 
claims to be able to work with pretty much any 
multimedia file.

In addition to ffmpeg, the command-line tool for 
converting multimedia formats, the package includes 
a streaming server called ffserver and a basic player 
called ffplay. Use ffrobe to display media information 
about a file.

Both Mencoder and FFmpeg are complex and you 
will often find that using internet searching will offer 
you the command line sequences that you need to 
achieve a task and those search results will determine 
the tool you use.

Both tools are 
incredibly versatile. They 
are driven by a large 
number of command 
line arguments and this 
complexity can, at first, 
present a barrier to new 

users. We’ll introduce some of the more common 
arguments and refer you to the man pages and web-
based documentation where you can learn more.

The natural complexity of these tools has brought 
about several GUI-based tools that try to simplify their 
use, with varying degrees of success. Ultimately, no 
GUI application can be as flexible as a comprehensive 
command line, and these tools present a good case 
for taking the time to learn their complexities instead 
of masking them with a GUI.

Codec container
These tools manipulate multimedia files – containers 
housing one or more streams of encoded data, 
usually audio and video and sometimes data such as 
subtitles. Encoding stores audio or video as a 
bitstream that can later be accessed by a decoder. 

FFMPEG AND MENCODER: 
COMMAND LINE VIDEO
Use your command-line prowess to make media files for any device.

The software that performs encoding and decoding is 
commonly referred to as a codec, and is defined by 
standards that can have multiple implementations. 
These implementations all produce acceptable input 
for any decoder, but may differ in the way they do it. 

One popular codec these days is called H.264, 
otherwise known as MPEG-4 Part 10 or AVC, the 
Advanced Video Codec. The usual open-source 
implementation is called x264. H.264 is very good 
at producing high-quality video with small file sizes 
and is therefore the current codec of choice for the 
internet and mobile devices. Blu-ray discs are also 
encoded using H.264.

The file itself is a container, and there are various 
container formats that you will encounter including 
AVI, MP4, MKV and Ogg. You will usually find H.264 
within an MP4, MKV or MOV container.

Both Mencoder and FFmpeg use the same 
libraries for the codecs (libavcodec) and containers 
(libavformat).

Enter the command line
So, how do we use them? Basic usage requires that 
you supply an input file, some options and an output 
file, like this example:
mencoder input-file -oac mp3lame -ovc lavc -o output-file.avi
The mencoder command reads the input-file and 
uses the given audio and video codecs to re-encode 
its contents, writing to the specified output-file. An 
ffmpeg command line sample to achieve a similar 
thing would be
ffmpeg -i input-file -acodec mp3lame -vcodec lavc -o 
output-file.avi

The input can be any file. The formats contained 
within the file are detected automatically. ffmpeg will 
display the format information if run without output 
instructions:
ffmpeg -i input-file
Alternatively, the supplied ffprobe command does the 
same thing:
ffprobe input-file

As an example, if you can’t play our free-and-open 
Ogg Video files on your smart television then don’t fret  
– just convert them into a MPEG transport stream 
that your TV will understand. Either
mencoder fosspicks_cable3.ogv -oac lavc -ovc lavc -lavcopts 
vcodec=mpeg2video:acodec=mp2 -of lavf -lavfopts 
format=mpegts -o fosspicks_cable3.mpg
or
ffmpeg -i fosspicks_cable3.ogv -vcodec mpeg2video -acodec 
mp2 -f mpegts fosspicks_cable3.mpg

“Ultimately, no GUI app can be 
as flexible as a comprehensive 
command line tool.”
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John Lane is a technology consultant with a penchant for 
Linux. He helps new business start-ups make the most of 
open source.

will give you an MPEG2 Transport Stream container 
that should be playable on your TV, because it uses 
the same mpeg2video and mp2 audio codecs that 
broadcast digital TV uses. 

Choose your command
These examples show the style of the command-
line options for each tool and highlights the subtle 
differences between them. The main difference 
is that Mencoder selects the codec library (-oac 
and -ovc) and then passes options in to them 
(-lavcopts). Because ffmpeg uses the library directly, 
its arguments are more clearly presented as ffmpeg 
options (-acodec, -vcodec, -f).

You can query Mencoder and FFmpeg to see their 
supported codecs and container formats:
mencoder -oac help -ovc help -of help
ffmpeg -formats
ffmpeg -codecs

The command line arguments -oac and -ovc take 
parameters that select the audio and video codecs 
to use, but here we instead use help to see what’s 
available. The third argument, -of, selects the output 
container format, and the most useful of these is lavf, 
which enables you to use any container format that is 
supported by FFmpeg’s libavformat library. Normally 
the format is inferred from the output fi lename, but it 
can be stated explicitly, as we did in our command line 
examples above.

FFmpeg can display more detailed information 
about a codec, for example
ffmpeg -h encoder=mpeg2video
lists all the command line options applicable to that 
codec. You will see that there are many options 
available.

You don’t have to use an input fi le. Using the 
x11grab option enables you to capture a screencast 
directly from your desktop:
ffmpeg -f x11grab -r 25 -s 1024x768 -i $DISPLAY -vcodec 
huffyuv screencast.avi

Here we explicitly set the input format and set the 
source to our X display. The huffyuv codec is lossless 
and captures the screen exactly as-is. We also set 
a frame rate and screen size. To make the resulting 
video useful, we should transcode it into a more useful 
format such as H.264.
ffmpeg -i screencast.avi -vcodec libx264 screencast.mp4 

This time, the input format is detected 
automatically from the input fi le. We just need to 
specify the video codec and output container. 

Live video streaming
As well  as encoding, FFmpeg can also stream 
content. Its ffserver component accepts feeds from 
ffmpeg clients and streams them over HTTP. Setting 
up a server requires a simple confi guration fi le called /
etc/ffserver.conf:
Port 80
<Feed feed.ffm> 
    File /tmp/feed.ffm 

</Feed> 

<Stream stream.swf>
    Feed feed.ffm
    Format swf 
    VideoCodec flv 
    VideoBufferSize 80000
    VideoSize 1024x768
    Noaudio
</Stream>                                                                                     

<Stream status.html>
    Format status
</Stream>

This minimal example sets up an incoming feed 
and an outgoing Flash video stream. It also sets up 
a status page that you 
can use to see what the 
server is doing. You run 
the ffserver as a daemon
ffserver &

Now, you use ffmpeg 
to provide a feed. We’ll 
use our screencast example to provide a live 
stream of our desktop (you might instead stream 
from a webcam).
ffmpeg -f x11grab -r 25 -s 1024x768 -i $DISPLAY http://
localhost/feed.ffm
You can then point a web browser at http://localhost/
stream.swf to see the live streaming video or at 
http://localhost/status.html to view the status of 
ffserver.

With Mencoder and FFmpeg, you can do just about 
anything you can imagine with multimedia fi les.They 
are complicated tools, but they’re both well worth 
making the effort to learn. 

ffserver is FFmpeg’s streaming server. You can view its status in a browser.

“MPlayer and FFmpeg are 
complicated, but are well worth 
making the effort to learn.”
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A short time ago I found myself at the 
head of a table one of the many 
restaurants of a large Las Vegas hotel. 

To the left of me, some of the very best Go 
programmers in the world were conducting a 
vociferous and sometimes vicious argument 
with those situated opposite, a collection of 
some of the world’s very fi nest Python 
programmers (these are not mutually exclusive 
sets, but it paints a nicer picture).

As I slurped on my noodles, I listened in 
wonder and some small degree of awe as the 
fundamentals of each language were subject to 
the sort of withering critique only possible if the 
participants have spent much of their lives 
worrying about integer sizes and garbage 
collection. There was much to-ing and fro-ing on 
DRY principles and boilerplate code.

Eventually, after slipping a small but exquisite 
rum baba down the hatch, I noticed attention 
had turned in my direction, as though having 
exhausted rational argument some sort of 
consensus could only be agreed by an 
independent arbitrator.

“You are all wrong” I said, daintily dabbing 
crumbs from my lower lip, “everything since 
6502 machine code was a mistake”.

I do have a weakness for the elegance of 
some well turned assembly, but it is true that, 
though ruthlessly effi cient, it is rather hard to 
express some of the modern world’s problems 
easily in the language of machines. The 
particular problem they were grappling with was 
concurrency, and it is indeed something that Go 
does more convincingly than Python. (Cue flame 
war.) But maybe that’s just because this is the 
best book-burning description of concurrency I 
have ever seen: http://concur.rspace.
googlecode.com/hg/talk/concur.html.

Nick Veitch 
was the original editor 
of Linux Format, a 
role he played until he 
got bored and went 
to work at Canonical 
instead. Splitter! 

Originator of gamingonlinux.com – and our games editor!

Second monitor to 
keep an eye on IRC

Dota2 addiction…

Microphone for 
when I feel brave!

Inspirational 
painting from 
my son

Obligatory Linux 
Voice DVD shot!

What version of Linux are you 
using at the moment?
Right now I’m using Linux Mint 16 
on the desktop, as I fi nd it comes 

with everything you need. I originally used 
Ubuntu, but I just don’t like their direction 
anymore. I also use Android on my Nexus 
4 as there isn’t a Linux distro for phones I 
am comfortable with putting on it yet.

And what desktop? Cinnamon 
or Mate?
Cinnamon 2.0. It has the best mix 
I’ve found between simplicity and 

features while not being KDE-flashy and in 
your face.

What was the fi rst Linux setup 
you ever used?
My fi rst taste of the Linux brew was 
actually Mandrake 9.2 before it 

became Mandriva – the fi rst PC that was 

purchased for me actually came with it 
pre-installed and I could never keep myself 
away from Linux since then.

What Free Software/open source 
can’t you live without?
It has to be Simple Screen Recorder, 
as it’s hands-down the best screen 

capture software around. Many people 
just use some sort of FFMPEG script that  
just crams everything audio/video 
together without making it sync correctly, 
where as SSR does this for you.

What do other people love but 
you can’t get on with?
Gnome Shell & Elementary. Give me 
back my darned minimise buttons! 

Elementary at least has a normal dock 
where applications minimise down to, 
but Gnome Shell is just trying too hard to 
be different. 
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In issue two, we challenged you lot to 
draw pictures using just 100 lines of 
Python and the turtle module. The 

results were so fantastic that it was too 
difficult to pick just one, so we’ve decided to 
take the cowards’ way and have a joint first 
place. Both entries used clever maths and 
clever programming, and they used them to 
create very different pictures. 

We’ll put all the entries (along with the 
source code) online at www.linuxvoice.
com/python-gallery, so head down there to 
see all the entries and to take a peek behind 
the scenes. Although the competition is 
now closed (and there are no more prizes), 
we’ll keep the website updated with any new 
pictures that are sent in. To get on the site, 
send your code to ben@linuxvoice.com. 

Congratulations to Steven Minton for creating this scene. The clouds and 
ferns are drawn using fractals, and loops draw the flowers. 

There’s lots of maths behind this entry. We’d love to tell you how 
Jonathan Whitaker created this masterpiece, but we haven’t a clue.

Just remember the simple rules: no more 
than 100 lines, and only the turtle module 
can be used.

The winners!
Steven Minton’s pastoral scene uses the 
relationship between maths and real life to 
create a country scene that’s far more 
detailed that we thought would be possible 
in just 100 lines. The second just shows off 
the inherent beauty of maths to create a 
quartet of abstract pieces. Both of them, we 
feel deserve a place in a gallery, but for now 
a page in Linux Voice will have to do.

Thanks to everyone who’s helped to make 
the Linux Voice competitions such a great 
success. Keep an eye out in future issues as 
we have some big plans!

This could be yours! The exclusive Linux Voice 
leet T-shirt is only available to the winners of the 
Linux Voice challenges.

LINUX VOICE ISSUE 2 
COMPETITION RESULTS
They are the elect to whom beautiful things mean 
only beauty. For the rest of us, beauty is Python
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